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Aims and Learning Objectives 

The overall aim of this course is to enable you to create and modify content to University 
standards on the University website using the TERMINALFOUR (T4) Site Manager. 

By the end of this course you will have gained a working knowledge of Site Manager and, as a 
Contributor, you will be able to: 

 add, modify, preview and delete content within existing sections; 

 add and modify content using Site Manager’s Direct Edit mode; 

 resize and optimise images for using on the web; 

 add images and files to Site Manager’s Media Library; 

 format content (including creating links and inserting images) using the built-in visual editor 
TinyMCE. 
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Introduction 

TERMINAL FOUR Site Manager is the new University of Bristol Web Content Management 
System (CMS) for public facing websites. It is a web-based tool for managing and publishing 
content on the University website. 

It makes it easier than ever for people with no technical knowledge of the web to edit and 
publish web content easily and quickly. 

Some of the CMS features and benefits include: 

 user-friendly interface; 

 easy content publishing via a Word-like WYSIWYG editor and Direct Edit mode; 

 flexible workflow management to ensure quality control; 

 flexible user rights and roles to control access to relevant areas of the website; 

 easy to enforce template and consistent look and feel; 

 built-in web accessibility and standards compliance. 

 

Prerequisites 

Basic computer skills. 
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Task 1 Getting to know Site Manager 
Objectives In this task you will: 

 learn how to access Site Manager; 

 learn to navigate around the Site Manager interface; 

 gain an understanding of website structure in Site Manager 

 gain an understanding of user rights and roles; 

 gain an understanding of the Site Manager workflow. 

Comments The URL to login to Site Manager is http://t4cms.bris.ac.uk 

 

1.1. Accessing Site Manager 

For this training course, you are allocated a training site, username and password.  

Make a note of the training site and login details as provided by the tutor: 

Username : tra___-cont (e.g. tra01-cont) 

Password : __________________ 

 
Open your preferred web browser and go to t4cms.bris.ac.uk (you may want to 
bookmark this URL). This takes you to the Site Manager login screen (Figure 1): 

 
Figure 1: Site Manager UoB login screen 

As a University web publisher it is your responsibility to ensure that the information 
you provide on your website is up-to-date, professional and accessible. Also, it must 
comply with current Data Protection, Freedom of Information and copyright 
legislation, and with the University's web accessibility policy. 
 
For further information on your responsibilities as a web publisher, please refer to 
http://www.bristol.ac.uk/web/guide/gettingstarted/responsibilities.html 

http://t4cms.bris.ac.uk/
http://t4cms.bris.ac.uk/
http://www.bristol.ac.uk/secretary/dataprotection/
http://www.bristol.ac.uk/foi/
http://www.bristol.ac.uk/web/guide/gettingstarted/copyright/
http://www.bristol.ac.uk/web/policies/full-access.html
http://www.bristol.ac.uk/web/guide/gettingstarted/responsibilities.html
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To log in to a live site, click on Sign in with SSO at the top and enter your UoB 
username and password prompted. 

 

Have a play: 
1.1 Log in to your allocated training site as a Contributor. 

 Launch your preferred browser (i.e. in the training room you have the choice 
between Internet Explorer and Google Chrome) and open t4cms.bris.ac.uk 

 In the Non-University of Bristol sign-on box login screen, enter the training 
Contributor Username and Password given to you by the tutor, then click Login. 

1.2. The Site Manager interface 

Once logged in as a Contributor you are presented with the Site Manager screen 
(Figure 2). 

 
Figure 2: Site Manager Contributor interface 

By default it displays the Show site structure screen, where you see the site(s) or 
section(s) of a site you can edit. 

A. Top menu – Here you can change the text size (default is medium), go back to 
the default Show site structure screen, see your username and assigned role 
(by hovering the mouse cursor over the username), search the content of your 
site and log out. You may ignore the Dashboard and Content Language 
options (English is the only option). 

B. Menu toolbar – As a Contributor you only have access to the Content and 
Help drop-down menus. Pointing the mouse cursor over these menus displays 
the options available (Figure 3). 

http://t4cms.bris.ac.uk/
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Figure 3: Content and Help menus options 

C. Current screen title – Shows your current action (e.g. Modify Content; Add 
Content; etc). Show site structure is the first screen you see after logging in; 
you can always come back to this screen by clicking the Site Structure icon in 
the top menu. 

D. Path – shows the path to the current location within the site structure. 

E. Site structure – Displays the top level section to which you have been granted 
access as a Contributor, and any sub-section(s) within it. You can use the plus 
(minus) sign to expand (collapse) sections that contain further sections. This 
forms a hierarchical (or tree) structure consisting of many levels. 

F. Section drop-down menu – Pointing the mouse cursor to the down arrow 
opposite the section you want to modify reveals options to add/modify/delete 
content within that section, as well as preview and bookmark it. 

G. Traffic lights column – The traffic lights indicate the number of content items in 
the section in each of three categories: 

 Green : content which has been approved for publication. 

 Amber : content waiting to be approved for publication. 

 Red : inactive content currently within the recycle bin waiting to be purged 
(i.e. deleted) from the system by an Administrator. 

H. Toggle columns – Click to show or hide the accessibility or/and traffic lights 
columns. 

I. Bookmarks widget – Shows a list of the sections and screens you heave 
bookmarked for quicker access. 

J. Bottom menu – This menu offers the same options as the top menu (see A) 
plus the option to bookmark the current screen (it will be listed in the Bookmarks 
widget). 

1.3. Website structure in Site Manager 

Sections and web pages 

Website structure in Site Manager is organised in the familiar hierarchical folder 
structure as used on a PC (Error! Reference source not found.), although it refers 
o them as sections rather than folders. 

The reason is that a section is at once a folder, because it can contain other 
sections (sub-sections), AND a web page because it displays content (i.e. text and 
images) within it as a single page. 
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Figure 4: Sample website structure in Site Manager 

The section entitled site properties is a special section. It contains properties 
associated with the website (e.g. the banner title) which cannot be edited by 
Contributors. 
 

A typical web page/section is made up of a template (called a Page Layout) that 
defines the look of the header, footer and left navigation menu, and a content area 
in between. 

Content blocks and Content Types 

The content area consists of any number of content blocks (at least one) to which a 
Content Type is applied. 

Figures 5 and 6 below show the same page created using a single content block 
and using two content blocks. 

Both pages look exactly the same, but the second one, by breaking the page into 
two smaller ‘chunks’, makes it easier to re-use a specific ‘chunk’ on another page, or 
to make it look different by using a different Content Type. 

The greyed out area around the content shows the Page Layout that has been 
applied to the page. 

A Content Type defines how the content block to which it is applied will look. For 
example we can have different Content Types for general content (as in this 
example), to publish news articles and events or to create an image carrousel. 

For standard web pages (i.e. pages requiring a simple layout and consisting mostly 
of linear text and possibly a few images) we recommend you create a single content 
block using the default Content Type (named Content block). 

However there may be times when you want to break down your page in several 
blocks to give you more flexibility to re-use a piece of content on other pages. 
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Figure 5 – Sample page built using a single content block 

 
Figure 6 – The same sample page built using two content blocks 
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1.4. User rights and roles 

In Site Manager, users can only be given one of five roles: Visitor, Contributor, 
Moderator, Power User and Administrator (Figure 7). 

 
Figure 7: User rights and roles in Site Manager 

As a University website maintainer, you will have one of two roles: Contributor or 
Moderator. 

As a Contributor: 

… you can … you cannot 

 add / modify / delete content 

 preview sections (and therefore their 
content) 

 access the Media Library to find 
images, PDFs, etc to link to 

 add images and other files to the 
Media Library 

 

 add / modify / delete sections 

 approve and publish content that you 
create 

 manage other users 

 create links in the left navigation 
menu 

 create sub-categories in the Media 
Library 

1.5. The Site Manager workflow 

The default workflow in Site Manager is quite simple: 

 A piece of content can be in one of 3 states: Draft  Pending  Approved 

 Content can also show as inactive when it has been deleted – this marks it for 
‘recycling’ which occurs automatically and results in the removal of all inactive 
items from the system. 

 As a Contributor, when you add a new content block to a section, or update an 
existing one, its status changes to Pending (unless you decide to Save as Draft, 
in which case its status will show as Draft) 
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 The relevant Moderator then will get notified and approve it for publication. 

 Contributors cannot publish to the live site the content that they create or 
modify, it needs to be Approved by a Moderator. 

Have a play: 
1.2 Explore the Site Manager interface: 

 Explore the features described above and see what happens. 
If you leave the Show site structure screen, click on the Site Structure icon in the 
top menu (you can also point to the Content tab in the menu toolbar (B) and select 
Site Structure). 
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Task 2 Adding content to a section 

Objectives In this task you will learn: 

 how to add content to an existing section 

 about Content Types and how to choose between different Content Types 

 about the Content tabs 

 how to enter text using TinyMCE 

 how to preview newly added content 

Comments There are different ways to add content in Site Manager. It is useful to be aware of 
them all, although in practice you may settle for a preferred method. 

 

2.1. Methods for adding a new content block to a Section 

There are 3 slightly different ways to do this in Site Manager: 

 using the section Content tab 

 using the section drop-down menu 

 using the Content menu 

It is useful to be aware of all of them, although in practice you may have a preferred 
one. 

Method 1: using the section Content tab 

1. In the Show site structure screen, navigate to the section you want to add content 
to (use the  icon to the left of each section if necessary). When you have located it, 
click on its name (Figure 8). 

 
Figure 8: Selecting the section you want to add content to 

This takes you to the section Content tab in the Modify content, select content 
screen. 

2. In the section Content tab, click on the + Add Content link (Figure 9): 
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Figure 9: Section Content tab screen 

Method 2: using the section drop-down menu 

1. Click on the Site Structure icon in the top menu (Figure 10) – or in the Content 
menu drop-down (see Figure 2B in Task 1). 

 
Figure 10: The Site Structure icon in the top menu 

2. In the Show site structure screen, navigate to the section you want to add content 
to and point the mouse cursor to the down menu opposite, then select Add Content 
(Figure 11). 

 
Figure 11: Adding content using the drop-down arrow opposite the relevant section 

Method 3: using the Content menu 

1. Point the mouse cursor to the Content menu (not to be confused with the Content 
tab showed above) and select Add Content (Figure 12). 
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Figure 12: Adding content using the Content drop-down 

2. On the Add Content, choose a section screen, navigate to and select the section 
you want to add content to (Figure 13). 

 
Figure 13: Choose the section you want to add content to 

2.2. Choosing a Content Type 

Whichever of the 3 methods described above you choose, you may * then be 
prompted to choose a Content Type (Figure 14): 

 
Figure 14: Choosing a Content Type 

 

A Content Type is the layout and style template that is applied to a content block. 
The most common one is Content block, which is used for standard web pages. 
There may be more Content Types to choose from in the future, and there may be 
Content Types that only apply to specific websites. 
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If prompted to choose a Content Type and unless told otherwise, choose Content 
block under the Global category (see Figure 14). 

* Whether you are prompted to choose a Content Type depends on whether there 
is more than one to choose from. If only the default Content Type (i.e. Content 
block) is available to you as a Contributor, then you will go straight to the Add 
content, enter content details screen. 

2.3. Entering content details 

You now see the Add content, enter content details screen > Content tab (Figure 
15) consisting of the following input fields: 

 Name – The name of the content block as it will be referred to in Site 
Manager. This field is mandatory but it is not visible to users of the website. 
You can use the same text as for the Title to which you should append 
[main] to indicate that this is the main (and possible unique) content block in 
the section (e.g. Study [main]). 

 Title – This field is will appear at the top of the page, as a heading level 1 
(h1). It is optional although in most cases you will want to include it. Make it 
as descriptive as possible of the page content (e.g. Study) 

 Body text – This is where you type in the content itself. By default, this field 
uses the TinyMCE visual editor. Using the editor is covered in detail in Task 
5. 

 Keywords – Optionally you can specify keywords for the content block. Use 
a comma to separate keywords. Note that their sole purpose is to make it 
easier to search for a particular content block in Site Manager. 

 
Figure 15: Entering details into the Content Type fields 
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 Whenever you see the icon [ ] on that screen there is a tool tip available; just 
point the mouse cursor to it and a tool tip will pop up (Figure 16). 

 
Figure 16: Tool tip pop up 

 Clicking on Preview opens a preview ot the page as it will look like when 
published in a separate browser tab. 

 Clicking the Add button saves the content block and submit it to a Moderator for 
approval – its status is set to Pending and it is saved as Version 0.1. 

 Alternatively you can choose to Save as Draft by pointing to the down arrow next 
to the Add button (Figure 17) 

 
Figure 17: Saving as draft 

In this case, it will be saved as Version 0.0.1. 

After saving you will see your new content block listed (Figure 18). 

 
Figure 18: Newly added content block in Content tab view 

You will also see confirmation that the content has been added successfully in 
the shape of a green message box that will appear at the top of the screen. 

2.4. The Add/Modify content tabs 

When you add a new content block (or update an existing one) you see the Content 
tab (see Figure 15 above) by default. However there are a number of other tabs 
alongside (Figure 19). 

 
Figure 19: Add/Modify content tabs 
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General Information 

The General Information tab (Figure 20) shows which Content Type is being 
applied to the content. 

 
Figure 20: Add/Modify content, General Information tab 

Placement 

When you have 2 or more content blocks in a section, the Placement tab (Figure 
21) allows you to re-order them. 

 
Figure 21: Add/Modify content, Placement tab 

By default content blocks are ordered in chronological order (i.e. the newest at the 
bottom). 

Note that there is another way to re-order content blocks, using the Move up and 
down arrows in the Modify content, select content screen. 
 

Channels 

 

The Channels tab (Figure 22) allows you to select which channel(s) the content will 
be published to. 

Channels allow sites to be published in different formats for different outputs. For 
example, in addition to a standard web channel, we may have a mobile channel, a 
tablet channel and a training channel. 
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Figure 22: Add/Modify content, Channels tab 

By default any new content will be published to all channels available, but it is 
possible to restrict publication to the Production channel (i.e. the public website) only 
by deselecting the others. 

As a Contributor you should not have to change the default Channels settings. 

Options 

The Options tab (Figure 23) allows you to optionally assign publish and expiry 
dates to content blocks to ensure that they are published, unpublished, reviewed or 
archived at the right time. 

 
Figure 23: Add/Modify content, Options tab 

Content that has reached its expiry date is clearly marked as Expired.  

When a review date has been set, the last person to have modified the content will 
be notified by email. 

Linked Content 

The Linked Content tab (Figure 24) shows which other content blocks within Site 
Manager (if any) have a hyperlink to this particular content block. 

Note that this tab is displayed only when modifying an existing content block, not 
when adding a new one (since it would not be possible to link to a content block 
before it was created). 
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Figure 24: Modify content, Linked Content tab 

2.5. Previewing content 

The easiest way to preview content once you have added it or saved it as draft is to 
use the drop-down arrow opposite the content block or section and select Preview 
(Figure 25). 

 
Figure 25: Previewing a content block 

This opens a preview of the published page in a new browser tab (Figure 26). It 
shows you what the page will look like on the live site. 
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Figure 26: Preview of published page 

Have a play: 
2.1 Add a content block to existing sections: 

 Using any of the methods described above, add a content block to all sections 
except About us. 

Tips for naming: 

 Name: use the same name or an abbreviation of the section name and add 
main to indicate this is the main content block (e.g. BOVI home (main); Study 
(main)) 

 Title: use the same as for the section (e.g. Bristol Oenology and Viticulture 
Institute; Study 

 Type a few words in the Body text field. 

 Optionally add keywords (e.g. oenology, viticulture, etc) 

 Before adding (or saving as draft), preview the content that you created if you wish. 
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Task 3 Modifying content 
Objectives In this task you will learn: 

 to edit existing content using the Modify Content option 

 to delete content 

 to move, duplicate and mirror content 

 to view content history and compare versions 

 to bookmark content 

Comments In the same way that there are a few options for adding new content, there are 
different options for modifying existing content. 

 

3.1. Methods for modifying existing content 

In the same way that you can add content using three different methods in Site 
Manager, you can modify existing content using similar methods: 

 using the section Content tab 

 using the section drop-down menu 

 using the Content menu 

Method 1: using the section Content tab 

1. Expand the site structure until you see the section containing the content block you 
want to modify. 

2. Click through on the section name (Figure 27) 

 
Figure 27: Clicking through the section to edit its content 

3. In the Modify content, select content screen, do one of the following: 

a) Click on the content block you want to edit (Figure 28). 

 
Figure 28: Choose the content block you want to edit 
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or: 

b) Point the mouse cursor to the down arrow of the content block you want to edit 
and select Modify (Figure 29) 

 
Figure 29: Select Modify from the down arrow options 

Method 2: using the section drop-down menu 

1. Expand the site structure until you see the section containing the content block you 
want to modify. 

2. Point the mouse cursor to the section drop-down menu, then select Modify Content 
(Figure 30): 

 
Figure 30: Modifying content using the drop-down arrow opposite the relevant section 

3. Do step 3 of the first method. 

Method 3: using the Content menu 

1. Point the mouse cursor to the Content menu and select Modify Content (Figure 
31). 

 
Figure 31: Modifying content using the Content drop-down 

2. Next, in the Modify content, choose a section screen, navigate to and select the 
section you want to add content to (Figure 32). 
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Figure 32: Clicking through the section to edit its content 

3. Do step 3 of the first method. 

3.2. Modify content, update details screen 

Whatever method you choose, they will open the Modify content, update details 
screen (Figure 33). This is where you can update the different elements of a 
particular content block (e.g. Name, Title), and in particular the Body text using the 
built in editor TinyMCE. 

 
Figure 33: Modify content, update details screen 

Have a play: 
3.1 Using the different options described above, modify 2 or more of the content 

blocks that you created in Task 2. 

 Feel free to modify any of the fields, but in particular the Body text in 
TinyMCE. 

 Select Update to save your changes. 

3.3. Deleting content 

To delete content, do the following: 

1. Navigate to the section which you want to delete content from. Once you have 
located it, click on its name in the Site Structure (Figure 34): 
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Figure 34: Locating the section containing the content to be deleted 

2. In the Content tab of the Modify content, select content screen, point the mouse 
cursor to the down arrow to the right of the content block you want to delete and 
select Delete from the drop-down (Figure 35): 

 
Figure 35: Selecting content for deletion 

A pop up warning will appear asking you to confirm whether you want to proceed or 
cancel. 

If you click OK you will get a confirmation message this particular content block has 
been set to Inactive (Figure 36): 
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Figure 36: Confirmation of Status changed to Inactive 

 

Restoring content marked as inactive 

‘Deleted’ content can be restored as long as it has not been recycled. 

1. Locate the deleted content block as explained above (see Figure 34). 

2. Click on the name of the content block you want to restore to modify it (Figure 37): 

 
Figure 37: Opening the content block to be modified 

3. In the Modify content, update details screen, select Update or Save as Draft 
(Figure 38): 

 
Figure 38: Reinstating an Inactive content block as Pending or Draft 

The Delete command is misleading in Site Manager because it does not actually 
delete the item, instead it changes its status to Inactive, which effectively marks the 
item for ‘recycling’. 
Content blocks marked as Inactive are still visible and can be reinstated. However 
the system will automatically ‘recycle’ them (i.e. delete forever) after 31 days. 
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The content block status will now show as Pending or Draft. 

3.4. Moving, duplicating and mirroring content 

As well as deleting content, you can move, duplicate and mirror it: 

 Move – means cutting a content block from one section and pasting it in another 

 Duplicate – means creating a copy of a content block and pasting it in the same 
or a different section. The copy and original are independent from each other, so 
changes made to one will not affect the other. 

 Mirror – means the same as duplicate (i.e. copying a content block and pasting it 
in another section) with a difference: any changes made to the original version 
will automatically be reflected in the copy (or copies) and vice versa. So all copies 
of a mirrored content block will always be identical. 

 

To move, duplicate or mirror content: 

1. Click on the Site Structure icon in the top menu (see Figure 10 in Task 2) – or in 
the Content menu drop-down (see Figure 2B in Task 1). 

2. In the Show site structure screen navigate to the section you want to move, 
duplicate or mirror content from, and either: 

 select Modify Content from the yellow drop-down menu opposite the content, 

or: 

 click through the section Name. 

3. In the Content tab, point the mouse cursor to the yellow drop-down arrow menu 
opposite the content block and select the relevant option (Figure 39): 

 
Figure 39: Moving, duplicating or mirroring content 

4. In the Move/Duplicate/Mirror content, select destination screen, navigate to the 
section you want to move the content to and click on its Name (Figure 40): 

Duplicate and Mirror should only be used exceptionally as it is best to avoid having 
duplicate content on a website. 
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Figure 40: Clicking through the section to move content to 

 

To remove mirrored content from one or more sections: 

It is possible to remove mirrored content from any section in which it appears, as 
long as you keep it in at least one section. 

1. Go to the section containing the mirrored content block you want to remove. 

2. In the Content tab, point the mouse cursor to the yellow drop-down menu opposite 
the content block and select Delete (Figure 41): 

 
Figure 41: Removing mirrored content 

3. Click OK when asked “Are you sure you want to delete this content?” (or Cancel if 
you’ve changed your mind!). 

Mirrored content is identified by a little red ‘snowflake’ icon next to its name. 
 

   
 

Pointing to the snowflake will show you a list of sections where the content also 
appears. 
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4. In the Confirm Content Deletion screen (Figure 42), you are given 2 options: 

 
Figure 42: Confirming how you want mirrored content removed 

 Remove from Section (default): select this option if you want to remove the 
mirrored content from this section, but keep it in others. 

 Delete Content: will make all mirrored instances of the content (including the 
original block) inactive and mark it for ‘recycling’ (i.e. permanent deletion) 

5. Choose the option you want (or keep the default one) and click Confirm. 

Have a play: 
3.2 Following the instructions above, try to delete, move, duplicate and/or mirror 

a content block. 

 At the end, try to remove a mirrored content block from one of the section in 
which it appears. 

 

3.5. Viewing content history and comparing versions 

To view content history: 

1. Navigate to the section containing the content you want check the history of (hint: 
start from the Show Site Structure screen). 

2. Either click on the yellow drop-down arrow opposite the relevant section and select 
Modify Content, or click through the section name. 

3. In the Content tab, click on the drop-down arrow opposite the relevant content block 
and select History (Figure 43): 

 
Figure 43: Accessing the history of a content block 
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The History tab in the Modify content, update details screen (Figure 44) shows 
the editing history for a particular content block (e.g. name, version, last modified, 
etc). 

 
Figure 44: Modify content, History tab 

You can also preview a particular version in a different tab by clicking on View, and 
to set an older version as the active one by clicking the Set Active link. 

To compare two versions: 

Once in the Modify content > History tab (see Figure 44 above), you have the 
option to compare 2 versions at a time. 

1. Select the two versions you want to compare by ticking the relevant check boxes in 
the Compare column. 

2. Click on the Content Comparison button and in the Compare screen (Figure 45), 
first select the field you want to compare (this will usually be the Body text). 

 
Figure 45: Compare screen options 

 

3. Then click on Text or HTML (choose the former if all you want to do is compare the 
text; if you also want to compare HTML tags, then choose HTML). 

The Visual Comparison option shows the changes in preview mode, however it is 
not as useful as comparing different versions side by side. 
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Figure 46: Comparing two versions of the same content 

Have a play: 
3.3 Following the instructions above, try to make changes to a content block 

and compare the different versions. 

 

3.6. Bookmarking content 

To bookmark a section and its content: 

1. In the site structure, navigate to the section you want to bookmark and click through 
it to display its Content tab. 

2. Click on the Bookmark link in the bottom right corner of the screen (Figure 47). 

 
Figure 47: Bookmarking content 

3. Replace the text in the Name field with the section name and click OK (Figure 48). 

 
Figure 48: Enter the section name 

4. Click on the Site Structure icon . The section is now listed in the Bookmarks 
widget. 
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To modify or delete a bookmark: 

1. In the Bookmarks widget, click on Edit and then on the Delete icon to remove the 
bookmark or Modify to edit its name (). 

 
Figure 49: Modifying or deleting a bookmark 

 

Have a play: 
3.4 Try to bookmark a section and to access it from the Bookmarks widget. 

 

There is a Bookmark Section option in the section drop-down menu, but due to a 
problem in Site Manager, if you bookmark a section using this method as a 
Contributor, you will not be able to access it. 
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Task 4 Using Direct Edit to add and modify content 
Objectives In this task you will learn: 

 to access the Direct Edit mode 

 to add content in Direct Edit 

 to modify and delete content in Direct Edit 

 to view content history in Direct Edit 

 to navigate the site structure in Direct Edit 

Comments Direct Edit mode is Site Manager’s highly visual way to edit your site’s content. The 
way it works is that you edit sections (i.e. web pages) in preview mode, so you see 
page content in context. It is particularly recommended for occasional users as it 
requires little knowledge of Site Manager. 

 

4.1. Accessing Direct Edit 

You can access Direct Edit in one of two ways: 

 using the Direct Edit option in the section drop-down menu in the main 
interface 

 using the ‘Edit this page’ link on a live web page 

Method 1: using the Direct Edit option in the section drop-down 
menu 

When logged into Site Manager’s main interface, as explained in Task 1, Getting to 
know Site Manager. 

1. From the Show Site Structure screen (Hint: click on the Site Structure icon in the 
top menu or in the Content menu drop-down), navigate to the section you want to 
add content to. 

2. Point the mouse cursor to the yellow drop-down menu arrow opposite the relevant 
section and select Direct Edit (Figure 50). 

 
Figure 50: Accessing Direct Edit 

Depending on which browser you use, Direct Edit opens in a new tab (Internet 
Explorer) or a new browser window (Google Chrome). 
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Method 2: using the ‘Edit this page’ link on a live web page 

1. In a web browser, open your live website and navigate to the page you want to 
modify. 

2. Look for the Edit this page link in the bottom right of the page, just above the footer, 
and click on it (Figure 51). 

 
Figure 51: Accessing Direct Edit through the Edit this page link 

3. Click on Sign in with SSO and enter your UoB username and password. 

4.2. The Direct Edit interface 

 
Figure 52: Direct Edit interface for Contributors 

A. Direct Edit toolbar – Here you can: 

 add a new content block to the current section (Add Content to Current 
Page button) 

 access the site structure (Site Structure button) to navigate to a different 
section 

 hide or display the toolbar (click the up / down arrows in the top right) 

B. Content area – Editable content blocks are identifiable by the thin dotted red line 
that delineates them. Hover the mouse cursor inside a content block to see the 
Modify, Delete and History options. 
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4.3. Adding content in Direct Edit 

1. Click on the Add Content to Current Page button and, if prompted, select a 
Content Type (Figure 53). 

 
Figure 53: Adding content and selecting a Content Type 

2. In the Content tab, fill in the content details as you did in Task 2, Adding content 
to a section (Figure 54). 

 
Figure 54: Filling in the Content details 

Optionally you may want to fill in the Options tab fields (Figure 55). 
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Figure 55: Filling in the Options details 

3. Click Save as Draft if you need to make further edits before submitting or Add to 
submit the page for approval. 

4.4. Modifying and deleting content in Direct Edit 

Once a section contains one content block, it can be edited straight away in Direct 
Edit mode. 

Any content block for which you have editing right is surrounded by a red dotted line. 

When you hover the mouse cursor towards the top of this area, it will change into an 
orange dotted line and 3 option tabs will appear in the top left: Modify, Delete and 
History (Figure 56). 

 
Figure 56: Content editing area in Direct Edit mode 

To modify content: 

1. Click on the Modify tab. This takes you to the Modify content screen, which is 
identical to the one you use to add content (see Figure 54 and Figure 55). 

2. Edit your content as desired and click Save as Draft if you need to make further 
edits before submitting or Update to submit the page for approval. 

To delete content: 

1. Click on the Delete tab. 
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2. A window will pop up, prompting you to confirm that you want the content to be 
deleted (Figure 57). 

 
Figure 57: Confirm content deletion window 

You will see a confirmation message appear at the top of the screen for a few 
seconds (Figure 58). 

 
Figure 58: Content deletion confirmation message 

Once deleted, the content will disappear from the page – although you will need to 
reload the page to see the change. 

4.5. Viewing content history in Direct Edit 

1. In the content editing area, click the History tab (Figure 56). 

The View Content history window (Figure 59) shows all the versions listed. 

 
Figure 59: View Content history window 

It allows you to replace the current (Active) version with a previous one by clicking 
the Set Active link. 

2. Click Cancel to leave the History view. 
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4.6. Navigating the site structure in Direct Edit 

1. Clicking on the Site Structure button opens a pop up menu showing the site 
structure (Figure 60). 

 
Figure 60: Site Structure pop up menu 

2. Navigate through the hierarchy to select the section you want to add content to, or 
whose content you want to modify. Click on the  and  icons to expand / collapse 
sections. 

Have a play: 
4.1 Following the instructions above, within the Study section, modify the main 

content in the Undergraduate courses and Postgraduate courses 
sections. 

4.2 Create a new content block in the About us section: 

 Use the Site Structure button to navigate to the About us section. 

 Then click on the Add Content to Current Page button and select 
Content block as the Content Type. 

 Enter a suitable Name (e.g. About us (main)), Title (i.e. About us) and a 
few words of your own to the main body text. 

 Finally, preview your pages and try the left navigation links that have been 
automatically created. 

 Select Save as Draft or Add to save your work. 
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Task 5 Adding media to the Media Library 

Objectives In this task you will learn: 

 to access the Media Library 

 to optimise images for the web using an online photo editor 

 to add media files to the Media Library 

 to delete media files from the Media Library 

 to move media files to a different category 

Comments The Media Library is where you keep all media files (e.g. images, PDFs, Office 
documents, etc) – except videos – related to a website in Site Manager. 

 

5.1. Introducing the Media Library 

The Media Library is where media files are stored in Site Manager. Media files 
include images, PDF files, Microsoft Office files, style sheets and scripts, but not 
videos. Once in the Media Library files are easy to access from within Site Manager, 
for example to create a link to a PDF file or insert an image in a web page. 

Accessing the Media Library 

To access the Media Library, go to Content > Media Library (Figure 61): 

 
Figure 61: Accessing the Media Library 

Interface 

 
Figure 62: The Media Library interface 
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A. Resize categories view navigation menu – allows you to widen or narrow 
the categories navigation menu. 

B. Add Media button – use to upload a new media file. 

C. Search – allows you to search for items in the Media Library, by name, 

keywords or description. 

D. Jump – allows you to search for media items by ID (if you happen to know it 

which is unlikely). Ignore. 

E. Filter – allows you to filter which file types are displayed (e.g. Image, Adobe 

PDF Document, Script, etc). 

F. Views – allow you to select how the media items are displayed. Click the icons 

to toggle between Detailed Mode and Preview Mode. 

G. Categories navigation menu – displays the hierarchy of available categories. 

H. Media items – this areas displays the content of the chosen category, in 
Detailed Mode or in Preview Mode (see F). 

5.2. Optimising images for the web 

Before using an image on a website, it is good practice to optimise it for the web. 
This means re-sizing it to the pixel dimensions (i.e. width and height) you want it to 
take up on the page and reducing its file size, and ensuring that it is in a suitable 
format. 

What is a good image size? 

A good size for an image depends on how you are planning to use it, but as a rule of 
thumb, 955 pixels is the maximum width needed on the University website (for a full 
page width banner for example). 

In the case of images used to illustrate a standard page and positioned to the right 
with the text on the left, you should use the recommended width of 283 pixels to 
ensure the image fits properly within the page layout. 

However there may be occasions (e.g. when it contains a lot of small details or 
textual information) when the image needs to be wider than 283 pixels. 

Note that the height is not so important, so you should always decide on the width 
first. 

What tools to use for resizing and cropping images? 

The quickest is to use a free online tool like Web Photo Resizer 
(http://www.webresizer.com) or Pixlr (http://pixlr.com): 

 Web Photo Resizer is very easy to use: click on the Resize Photos Now 
button, upload your image, set the width (leaving all other options as they are), 
click the apply changes button and download the resized image. 

 Pixlr is a full blown image editor with Photoshop like capabilities. Choose the 
advanced option (Open Pixlr editor) and select Open image from computer 
to upload an image. Then go to Image > Image size and enter the width you 
want (the height will automatically adjust provided Constrain proportions is 
selected). Click OK. Go to File > Save (choose a suitable file format – see 
below). 

Alternatively use Serif PhotoPlus which should be pre-installed on your University 
computer (go to Start > All Programs > Serif Applications) or any other photo 
editor you may have access to (e.g. Photoshop CS / Elements, Google Picasa, etc). 

http://www.webresizer.com/
http://pixlr.com/
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Which file format? 

There are three file formats for the web: 

 JPG (or JPEG): best for photos and images with lots of colours but no 
transparency. You can set the level of quality between 10% and 100% - don’t 
go for 100% for web images, instead choose 80% which is still high, but will 
reduce the file size considerably. 

 GIF: for a long time the default format for logos and graphics with solid areas 
of colour. However it can only display a maximum of 256 colours and for this 
reason it is not suitable for photos. 

 PNG: seen as a replacement for GIF, over which it has many advantages: 
not limited to 256 colours; better transparency support (useful for creating 
images with transparent backgrounds); smaller file size (a PNG image is 
about 20% smaller than the same images saved as GIF). You should use 
this format instead of GIF whenever possible. 

Have a play: 
5.1 Optimise an image using Web Photo Resizer: 

 Open webresizer.com in a browser. 

 Click on the Resize Photos Now button and upload an image (open 
Windows Explorer and use images located in Favorites > Public > Public 
Pictures > Sample Pictures) – note that the maximum size allowed is 
10MB. 

 Set the width size to 283px, leave the Sharpen and Image quality options 
as they are. 

 Click on the apply changes button followed by the download this image 
link and save the optimised image locally (e.g. in Favorites > Downloads) 
– at this stage you can rename the file to a web-safe name (see note on 
next page). 

 If you have time you can also try the crop option with another image and 
save it in the same folder. 

 

5.3. Uploading images and other media files 

1. Open the Media Library (see Figure 61 above) and navigate to the category in 
which you want to upload a media file. 

2. Click on the Add Media button (see Figure 62 B above). 

3. In the Media Library screen, General tab, (Figure 63), fill in the following fields: 

 Name: enter a brief description of the media (in the case of a PDF or Office file 
enter the document title). 

 Description: DO NOT enter a description as this would be used by default as the 
image alternative text and may not be appropriate to the context in whith the 
image is used, or reflect its function (e.g. if used as a link). 

 Keywords: optionally enter relevant keywords (these can be useful when you 
search the Media Library). 

 Media: use this field to navigate to the media file location on your system. 

http://www.webresizer.com/
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Figure 63: Media Library General tab options for uploading a new media 

 

4. Click Add when done. 

The media is now listed in the relevant category (Figure 64): 

 
Figure 64: Newly added media 

Before uploading files to the Media Library, make sure that all file names are web-
safe; i.e. all lower case (no capital letters), not containing spaces (use a hyphen to 
separate words) or special characters (e.g. accented characters) and including the 
extension. 
Beware that non-web-safe file names may result in broken links in some browsers. 
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Have a play: 
5.2 Following the instructions above add an image and a PDF file to the Media 

Library: 

 Add the image you have optimised previously to the Training > images 
category – include your training site number in the name (e.g. Grapes 01). 

 Optionally, add a PDF file to the Training > documents category, again 
including your training site number in the name. 

 

5.4. Deleting media from the Media Library 

If you are in the View Media in Detailed Mode: 

1. Click on the Delete icon opposite the media you want to delete (Figure 65) and 
confirm when prompted: 

 
Figure 65: Deleting in the View Media in Detailed Mode 

If you are in the View Media in Preview Mode: 

1. Hover the mouse cursor over the media you want to delete and click on the 
Advanced button (Figure 66): 

 
Figure 66: Deleting in the View Media in Preview Mode 

This opens the media details view (Figure 67): 
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Figure 67: Media details view, Delete 

2. Click Delete and confirm when prompted. 

Notice that if the media you try to delete is used on a page you will receive a 
warning (Figure 68): 

 
Figure 68: Media usage deletion warning 

In this case DO NOT PROCEED, as this will result in a broken link on those pages 
that have a link to it. 

5.5. Assigning media to other categories 

There are no Move or Cut / Copy & Paste options in the Media Library. Instead 
media are assigned to categories or sub-categories. 

By default, media item are assigned to the category in which they are added. 
However it is possible to assign a media item to different categories after it has been 
added. 

If you are in the View Media in Detailed Mode: 

1. Click on the Modify icon opposite the media you want to delete (Figure 69) and 
confirm when prompted: 
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Figure 69: Modifying in the View Media in Detailed Mode 

2. Select the Categories tab (Figure 70): 

 
Figure 70: Selecting the Categories tab 

3. Once in the Media Categories screen, select or de-select the categories you want 
to add or remove the media in / from (Figure 71) and click Update. 

 
Figure 71: Selecting / de-selecting categories 

If you are in the View Media in Preview Mode: 

1. Hover the mouse cursor over the media you want to delete and click on the 
Advanced button (see Figure 66 above). 

2. In the media details view, click Modify (Figure 72): 
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Figure 72: Media details view, Modify 

3. Follow steps 2 to 3 above. 

Have a play: 
5.3 Following the instructions above reassign a media to a different category: 

 Go to the Media Library and reassign the PDF file you uploaded earlier to 
the Training > documents category. 
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Task 6 Editing and formatting text in TinyMCE 

Objectives In this task you will learn: 

 to use basic text formatting (e.g. headings, lists, etc) correctly 

 to create links (to other websites, to sections in your website and to bookmarks 
within a page) 

 to create links to non-HTML files (e.g. PDFs) stored in the Media Library 

 to create data tables 

 to add and position images from the Media Library 

Comments This final task focuses on editing the content of pages using TinyMCE, a simple 
WYSIWYG1 content editor. Whatever editing method you use (standard or Direct 
Edit) you will use TinyMCE 

 

6.1. Before you start 

The content editor toolbar 

The content editor toolbar (Figure 73) will be familiar as it uses similar icons to those 
seen in other word processing applications such as Microsoft Word; for example 
icons for making text bold, creating bullet lists, etc. 

However some icons will be new as they are specific to web content editing within 
Site Manager. 

 
Figure 73: TinyMCE content editor toolbar 

The faded out tools are inactive until needed (e.g. the table formatting options at the 
bottom become active when a table has been created and is selected). 

For a full list of tools available in TinyMCE, please refer to Appendix AAppendix A. 

                                                
1
 What You See Is What You Get 
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Working in full screen mode 

For longer edit and when working in Direct Edit mode you may want to switch the 
editor to full screen. 

To do this, click on the Toggle fullscreen mode icon (Figure 74). Click on it again 
to go back to Site Manager or Direct Edit view. 

 
Figure 74: Switching to full screen mode for easier editing 

Warning!     Fullscreen mode does not open a separate window, so ensure you do not close the 
browser tab or window by mistake as this will result in losing your edits. 

The context menu 

The context menu can be accessed by right-clicking on any element (word, 
paragraph, image, table cell, etc) on the page. 

The tools available in the context menu depend on the actions that are possible with 
the currently selected element in the WYSIWYG view of the editor. 

For example right-clicking on a group of selected words will give you the options to 
cut, copy and paste, and to insert a link (Figure 75). 

Notes on copying and pasting content from other sources 
 
The cut, copy and paste options currently only work in Internet Explorer, so if you 
use Google Chrome or Firefox, you will need to use the context menu (see below) or 
the keyboard shortcuts (i.e. <CTRL> + X for cut, <CTRL> + C for copy and <CTRL> + 

V for paste). 
 
Copying and pasting from a Microsoft Word, PDF document or web page: 

Simply use the Paste icon  in the toolbar or the <CTRL> + V keyboard shortcut. 

DO NOT USE THE Paste from Word icon  as it will add a lot of unwanted 
styling. 
 
Copying from Google Mail: 

Before pasting, click on the Paste as Plain Text icon  and THEN the Paste icon 
(or <CTRL> + V). 
 
In both cases, you will probably need to reformat your content in TinyMCE 
afterwards. 
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Figure 75: Accessing the context menu 

6.2. Structuring text: paragraphs, headings and lists 

Paragraphs and headings 

When you start typing the text will be automatically formatted as a paragraph: 

 Pressing <ENTER> will create a new paragraph. 

 Pressing <SHIFT> + <ENTER> will create a line break. 

To create a heading, select the text (or place the mouse cursor anywhere in the 
paragraph) you want to make a heading and select one of the options from the 
Format drop-down box in the Toolbar (Figure 76). 

 
Figure 76: Creating a level 2 heading 

 
Lists 

Lists come in two types: unordered (ie bullet) and ordered (ie numbered). To insert 
a list: 

1. Type the list items one by one as separate paragraphs (press <ENTER> at the end of 
each item). 

Heading formatting starts from Heading 2 because Heading 1 is reserved for the 
page title and is automatically created by the system when using a Content Type 
with a Title field. 
 

Rules for using headings: 
 

 Use the different heading levels in their intended, logical order (ie start from 
Heading 2 to introduce the main sections in your page, followed by Heading 3 
for sub-sections and, if necessary Heading 4 for sub-sub-sections). 

 

 Finally, use headings for their intended purpose (ie as section headings); do 
not use them for anything else (eg for making text bold or for image captions). 
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2. Select all items with the mouse and click either of the list icons:  for an 

unordered list and  for an ordered list. 

3. To take a list item out of a list, click the same list icon (it is highlighted) again – the 
item is automatically formatted as a paragraph. 

Have a play: 
6.1 Copy and paste content from a Word document in the About us section: 

 Open the Word document named about.docx (the trainer will show you 
where to find it) then select all its content and copy it. 

 Modify the About us (main) content block and click the TinyMCE Toggle 
fullscreen mode icon if you want (see Figure 74 above). 

 Delete any existing content and press CTRL + V on your keyboard to paste 
the content – if you use Internet Explorer as your browser you can also 

click the Paste icon  

6.2 Add formatting to the text: 

 Select each section heading (i.e. Background, Mission, Vision, 
Activities, Research, Study, Consultancy) in turn and apply the correct 
heading level. 
Hint: the last 3 are sub-headings of Activities. 

 Look for paragraphs that naturally lend themselves to be formatted as lists 

and apply convert them to bullet  or numbered  lists as appropriate. 

 Save your changes as draft (Save as Draft option in the Update drop-
down). 

 

6.3. Creating links 

You may want to add a link to an external website, to another page in your site, or to 
a specific target within a page. 

Linking to external websites 

1. Select the text you want to make a link then click on the Insert/edit link icon  in 
the toolbar. This opens the Insert/Edit Link dialogue box (Figure 77): 

 
Figure 77: Insert/Edit Link dialogue box, General tab options 
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2. In the Link URL field, type in the external website URL (eg 
http://www.bbc.co.uk/news for a link to the BBC News website) – if you forget to 
include the http:// prefix a message will pop up asking if you want it added; click OK 
to accept. 

Target attribute: leave the default option Open in This Window/Frame – 
exceptionally you may change it to Open in New Window (_blank). 

Title attribute: use this to provide additional text to describe the link or add useful 
information about the link. 
For example if you forced a link to open in a new window you could use the Title 
attribute to warn users by saying link opens in new window. 

Ignore the Class attribute and the other tabs. 

3. Click the Insert button. 

Have a play: 
6.3 Following the instructions above, create a couple of links to external 

websites: 

 Modify again the About us (main) content block and in the body text field, 
locate the 4th paragraph in the Background section (“We work in 
partnership with English Wine Producers and the United Kingdom 
Vineyards Association.”). 

 Select the text English Wine Producers and link it to 
www.englishwineproducers.com 

 Repeat for the text United Kingdom Vineyards Association, linking it to 
www.ukva.org.uk 

 Save your changes as draft, then preview your page and try the links. 

 

Linking to another Section or content block in Site Manager 

1. Select the text you want to make a link then click on the Insert Section Link icon 

 in the toolbar (or the Insert Content Link icon  if you want to link to a 
specific content block within a section). This opens the Choose a section to link 
dialogue box (Figure 78): 

 
Figure 78: Choose a section to link dialogue box 

http://www.bbc.co.uk/news
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2. Using the Site Structure, navigate to the Section you want to link to. 

 
 

Have a play: 
6.4 Following the instructions above, create a couple of links to other Sections: 

 Modify again the About us (main) content block and locate the body text 
field. 

 In the Background section, 1st paragraph, select the text Bristol 
Oenology and Viticulture Institute (BOVI) and link it to your site 
homepage 

 Now scroll down to the Activities section and in point 2 of the numbered 
list, select the text programmes of study and link it to your site’s Study 
section. 

 Save your changes as draft, then preview your page and try the links. 

 

Linking to a Microsoft Office or PDF file 

 

1. Place the mouse cursor where you want to insert your link and click on the Insert 

Media icon . 

This opens the Media Library browser (Figure 79): 

 
Figure 79: Media Library browser 

2. In the Media Library browser, navigate to the folder containing the file you want to 
link to and click on its name in the Media Name column. 
The file Media Name as well as the file type and size in brackets will be 
automatically used as the link text. 

The Site Structure shows the entire University website starting from the University 
homepage. Therefore you can use this method to link to any website hosted in T4 
Site Manager. 
For other University websites not in Site Manager you will need to use the method 
for linking to external websites. 

All media files including Microsoft Office and PDF files are stored in the Media 
Library. As a Contributor you can view and link to files in the Media Library but 
you cannot add files to it, this can only be done by Moderators. 
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Have a play: 
6.5 Following the instructions above, create a link to a PDF file in the Media 

Library: 

 Again, modify the About us (main) content block and locate the body text 
field. 

 Create a link to the BOVI newsletter located in the Media Library > 
Training > documents. 

 Update the page, preview it and click on the link to test it. 

 

Linking to an email address (mailto link) 

 

1. Select the text you want to link to an email address and click on the Insert/Edit link 

button . 

2. In the Link URL field type in (or paste) the email address (e.g. 
joe.blog@bristol.ac.uk) and click Insert. 

3. Click OK when prompted to add the required mailto: prefix. 

Warning!     If you copy a linked email address from a web page (e.g. from the University 

Contact Directory), make sure you click on the Paste as Plain Text button  
before pasting. This is particularly important if you use Google Chrome as it will 
force the mail to link to open Google Mail. 

6.4. Adding and positioning images 

Selecting an image from the Media Library: 

1. Place the mouse cursor where you want to insert your link and click on the Insert 

Media icon . This opens the Media Library browser (see Figure 79 above). 

2. In the Media Library browser, navigate to the folder containing the image you want 
to insert and click on its name in the Media Name column. 

This opens a preview of the image offering a choice of predefined sizes (Figure 80): 

 
Figure 80: Selecting an image from the Media Library 

The mailto link text should clearly indicate that the link will activate an email 
program. This can be achieved by either using the email address as the link (e.g. 
joe.blog@bristol.ac.uk) or a phrase like Email the School of Humanities office. 

mailto:joe.blog@bristol.ac.uk
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3. Under the Variations tab, select the size option you want and click Select. 

Modifying the image attributes: 

Site Manager will automatically insert the image description as the text equivalent 
(Alt attribute) in the image tag (i.e. <img alt=”image description”… />). However if 
you need to modify it or want to add a title attribute, do the following: 

4. Right-click on the image and in the pop-up context menu, select Edit Media 
Attributes (Figure 81): 

 
Figure 81: accessing the Media Attributes dialogue box 

This opens the Set Media Attribute dialogue box (Figure 82): 

 
Figure 82: Setting the media attributes 
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You can change the Alt text in the description field at the top. 

If the image is used as a link you can also use the title attribute to indicate what 
happens when the image is clicked (e.g. if the image represents Winston Churchill 
and it links to his Wikipedia entry then a suitable title would be: Opens the 
Wikipedia entry for Winston Churchill). 

Right aligning the image: 

You can easily align an image to the right of your page with the text on the left by 
applying a style class (note that there is no equivalent class to align images to the 
left). 

5. Open the Set Media Attributes dialogue box as described in step 4 above and in 
the class field type: 

a) align-right when the image is the standard width (283 pixels); 

b) align-right-no-width when the image width is different from 283 pixels. 

6. Click Update in the Set Media Attributes dialogue box and again (or Save as 
Draft) when back in the Content tab view. 

Have a play: 
6.6 Following the instructions above, insert an image in one of the pages: 

 Go to your root section (BOVI home) and modify the content. 

 In the editor, place the cursor at the beginning of the first paragraph, then 
click on the Insert Media icon to access the Media Library. 

 In the Medial Library, navigate to Training > images and pick an image. 

 Position it to the right. 

 Update and preview your changes. 

 

6.5. Creating data tables 

 

Basic table creation: 

1. Place the mouse cursor where you want to insert a data table and click on the Insert 

a new table icon . This opens the Insert/Edit Table dialogue box and shows the 
General settings (Figure 83): 

Set the options for your table using the General settings as follows: 

 Cols / Rows: sets the number of columns and rows including header 
rows/columns. 

 Cell Padding: adds space between the edges of cells and the text; set it to 4 or 5 
pixels. 

 Cell Spacing: adds space between cells; best left to 0. 

Data tables should be used to present lists of at least two related items with two or 
more categories of information (i.e. at least two rows and two columns), and to 
compare numerical data. 
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 Alignment: sets the horizontal alignment: Left (default), Center and Right; best 
left to default as this can be set in a style sheet. 

 Width / Height: leave blank as this is best left to adjust automatically to fit the 
text. 

 Class: can be used to link to a style sheet. 

 Table Caption: tick this box (you will then need to type a caption above your 
table). 

 Make first row / column a header: defines header rows / columns; your table 
should have a header row, so tick this box, and optionally the header column 
option. 

 
Figure 83: Insert/Edit Table General options 

2. Click Insert / Update. 

3. Type in the row and/or column headers and the data. 

Making tables accessible: 

 

1. Left-click anywhere in the table and then right-click. In the pop-up context menu 
select Table Properties. 

2. In the Insert/Edit Table dialogue box, select the Advanced tab (Figure 84): 

See accessibility.psu.edu/tableshtml for further information on data tables 
accessibility. 

Select only if the 
table’s leftmost column 
is a header column. 

http://accessibility.psu.edu/tableshtml
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Figure 84: Insert/Edit Table Advanced options 

3. In the Summary field enter a brief description of the table (e.g. Table representing 
the percentages of UK adults who drink wine by age group) – not that this is an 
accessibility requirement. 

Leave all other fields empty (in particular do not use the Border Color and 
Background Color as this is better done in a style sheet). 

Click Update when done. 

4. Next click anywhere on the header row (i.e. the top row) and then right-click. Select 
Cell > Table Cell Properties (Figure 85): 

 
Figure 85: Selecting the Table Cell Properties 

In the Table Cell Properties dialogue box (Figure 86): 

 check that the Cell Type is set to Header 

 set the Scope option to Column 

 select Update All Cells in Row from the drop-down just above the Update 
button: 

 click Update when done. 



Introduction to T4 Site Manager (its-t4sm-1t)  

53 

 
Figure 86: Table Cell Properties dialogue box 

 

5. Finally, click again on the header row, then right-click and select Cell > Table Row 
Properties. 

In the Table Row Properties dialogue box (Figure 87): 

 set the Row Type to Header 

 check that the drop-down option above the Update button is set to Update 
Current Row 

 click Update 

 
Figure 87: Table Row Properties dialogue box 

Note that if the table had a header column on the left, you would need to repeat this 
step, setting the Scope to Row and the drop-down field above the Update button to 
Update All Cells in Column. 
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Applying basic styling 

1. Left-click anywhere in the table and then right-click. In the pop-up context menu 
select Table Properties. 

2. In the Class attribute, select (value) from the drop-down and type table-basic in the 
now blank field (Figure 88). 

 
Figure 88: Adding basic styling to a table 

 

 

Have a play: 
6.7 Create a simple data table with a header row and a header column using 

your own or the following data: 

 2012 2011 2010 2009 2008 

Red Bordeaux 8 8 10 10 8 

White Bordeaux 7 8 7 7 8 

Red Burgundy 9 8 9 9 7 

White Burgundy 8 8 9 8 7 

 
Caption: French Vintages 2008-2012 

Summary: French vintages score out of 10 from 2008 to 2012 

 Make sure the table is fully accessible. 

 

The CSS class table-basic is part of the UoB template stylesheet and defines 
default styling for data tables. 
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Appendix A List of TinyMCE toolbar icons 
 

 
Make selected text Bold 

 
Insert a horizontal ruler 

 
Make selected text Italics 

 
Make selected text 
Subscript 

 
Text formatting styles 
(e.g.paragraph, heading 2)  

Make selected text 
Superscript 

 
Cut * 

 
Insert custom character 
(e.g. accented characters) 

 
Copy * 

 
Toggle full screen mode 

 
Paste * 

 
Edit HTML source 

 
Paste as plain text 

 
Insert link to a Section 
within SM 

 
Paste from Word (DO NOT 
USE THIS WHEN 
PASTING FROM WORD) 

 
Insert link to a specific 
content block within SM 

 
Select all 

 
Insert a link to a media 
item (e.g. image, PDF) in 
the SM Media Library 

 
Insert / edit hypertext link to 
an external web page  

Run the spell checker 

 
Unlink (remove link) 

 
Insert a new data table 

 
Find 

    
Edit table row properties 

 
Find and replace 

    
Edit table cell properties 

 
Format selected 
paragraphs as unordered 
(bullet) list 

      
Insert new table row above 
/ below 

 
Format selected 
paragraphs as ordered 
(numbered) list 

    
Delete table row 

   
Outdent / Indent (use the 
latter to create sub-lists)       

Insert new column before / 
after 

 
Format paragraph as 
blockquote     

Delete column 

   
Undo / Redo previous 
actions     

Split merged table cells 

 
Format selected text as a 
Citation     

Merge selected table cells 

 
Format selected text as an 
Abbreviation 

  

 


